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Important Information

Warranty

The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date 
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace 
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not 
execute programming instructions if National Instruments receives notice of such defects during the warranty period. 
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs 
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages 
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. 
Any action against National Instruments must be brought within one year after the cause of action accrues. National 
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty 
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, 
or other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without 
the prior written consent of National Instruments Corporation.

Trademarks

CVI™, HS488™, LabVIEW™, NAT4882™, natinst.com™, NI-488™, NI-488.2™, NI-488.2M™, TNT4882™C, and 
Turbo488™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical 
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the 
user or application designer. Any use or application of National Instruments products for or involving medical or clinical 
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards, 
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always 
continue to be used when National Instruments products are being used. National Instruments products are NOT intended 
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health 
and safety in medical or clinical treatment.



 

  FCC/DOC Radio Frequency Interference 
Class B Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance 
with the instructions in this manual, may cause interference to radio and television reception. Classification 
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). This equipment has been tested and found to comply with the 
following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables 
of suitable quality and construction. National Instruments used such cables to test 
this device and provides them for sale to the user. The use of inferior or nonshielded 
interface cables could void the user’s authority to operate the equipment under the 
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.
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About

This

Manual

This manual contains instructions for installing and configuring the 

National Instruments AT-GPIB/TNT or AT-GPIB interface board and the 

GPIB software for Windows NT. The GPIB software is intended for use 

with Windows NT version 4.0 or later. 

This manual assumes that you are already familiar with Windows NT.

How to Use the Manual Set

Use this getting started manual to install and configure your AT-GPIB/TNT 

or AT-GPIB and the GPIB software for Windows NT.

GPIB User
Manual for

Win32

Application
Development
and Examples

Novice
Users

Experienced
Users

NI-488.2M Function
Reference Manual

for Win32

Function
and Routine
Descriptions

Getting Started
Manual

Installation and
Configuration
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About This Manual

Use the GPIB User Manual for Win32 to learn the basics of GPIB and how 

to develop an application program. This manual also contains application 

examples and troubleshooting information.

The NI-488.2M Function Reference Manual for Win32 contains specific 

NI-488 function and NI-488.2 routine information, such as format, 

parameters, and possible errors.

Organization of This Manual

This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 

you need to get started, provides an overview of the AT-GPIB/TNT and 

AT-GPIB boards and the GPIB software, and describes optional 

equipment you can order.

• Chapter 2, Hardware Configuration and Installation, describes how to 

configure and install your AT-GPIB/TNT or AT-GPIB board. 

• Chapter 3, Software Installation and Configuration, describes how to 

install and configure the GPIB software for Windows NT. 

• Chapter 4, Verify the Installation, describes how to verify the hardware 

and software installation.

• Chapter 5, Begin to Use the GPIB Software, helps you get started with 

the GPIB software for Windows NT.

• Appendix A, Uninstalling the Hardware and Software, describes how 

to uninstall your AT-GPIB/TNT and the GPIB software from 

Windows NT.

• Appendix B, Troubleshooting and Common Questions, describes how 

to troubleshoot problems and answers some common questions.

• Appendix C, Specifications, describes the electrical, physical, and 

environmental characteristics of the AT-GPIB/TNT and AT-GPIB and 

the recommended operating conditions.

• Appendix D, Customer Communication, contains forms you can use to 

request help from National Instruments or to comment on our products 

and manuals.

• The Glossary contains an alphabetical list and description of terms that 

appear in this manual, including abbreviations, acronyms, metric 

prefixes, mnemonics, and symbols.
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About This Manual

Conventions Used in This Manual

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options»Substitute 

Fonts directs you to pull down the File menu, select the Page Setup item, 

select Options, and finally select the Substitute Fonts option from the last 

dialog box.

This icon to the left of bold italicized text denotes a note, which alerts you 

to important information.

This icon to the left of bold italicized text denotes a caution, which advises 

you of precautions to take to avoid injury, data loss, or a system crash.

bold Bold text denotes the names of menus, menu items, dialog boxes, dialog 

box buttons or options, icons, windows, or Windows tabs.

bold italic Bold italic text denotes a note or caution.

GPIB board GPIB board refers generically to either the AT-GPIB/TNT or AT-GPIB 

board when information can apply to either board.

IEEE 488 and IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard 488.1-1987 

IEEE 488.2 and the ANSI/IEEE Standard 488.2-1992, respectively, which define the 

GPIB.

italic Italic text denotes disk names, variables, emphasis, a cross reference, or an 

introduction to a key concept. 

monospace Text in this font denotes text or characters that you should literally enter 

from the keyboard, sections of code, programming examples, and syntax 

examples. This font is also used for the proper names of disk drives, paths, 

directories, programs, subprograms, subroutines, device names, functions, 

operations, variables, filenames and extensions, and for statements and 

comments taken from programs.

monospace bold Bold text in this font denotes the messages and responses that the computer 

automatically prints to the screen.

monospace italic Italic text in this font denotes that you must enter the appropriate words or 

values in the place of these items.

!
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About This Manual

Related Documentation

The following documents contain information that you may find helpful as 

you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 

for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats, 

Protocols, and Common Commands

• LabVIEW Function and VI Overview Manual

• LabVIEW User Manual

• LabWindows/CVI Standard Libraries Reference Manual

• LabWindows/CVI User Manual

• Microsoft Windows NT System Guide, Microsoft Corporation

Customer Communication

National Instruments wants to receive your comments on our products 

and manuals. We are interested in the applications you develop with our 

products, and we want to help if you have problems with them. To make it 

easy for you to contact us, this manual contains comment and configuration 

forms for you to complete. These forms are in Appendix D, Customer 

Communication, at the end of this manual. 
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Chapter

1Introduction

This chapter explains how to use this manual, lists what you need to get 

started, provides an overview of the AT-GPIB/TNT and AT-GPIB boards 

and the GPIB software, and describes optional equipment you can order.

How to Use This Manual

Gather What You Need
to Get Started

Chapter 3

User Manual and
Function Reference

Manual

Chapter 1

Write Application Program

Configure the 
GPIB Hardware (Optional)

Install the GPIB Hardware

Install the GPIB Software

Configure the GPIB Software

Verify the Installation

Yes

No
Passes?

Run Interactive Control Utility

Review Programming
Considerations

Troubleshooting

Chapter 4

Chapter 5

Chapter 2
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What You Need to Get Started

Make sure you have all of the following items before you install your GPIB 

hardware and software for Windows NT:

❑ Windows NT version 4.0 or later installed on your system

❑ One of the following boards:

AT-GPIB/TNT

AT-GPIB

❑ GPIB Software for Windows NT/98/95 CD, which comes in your kit

❑ GPIB cables—single-shielded or double-shielded, Type X1, X2, or 

X5, which you can order from National Instruments.

Note If you do not have a CD drive and would like to order the GPIB software on 

floppy disks, contact National Instruments and order part number 777780-01.

Optional Equipment

Call National Instruments for more information about the following 

optional equipment:

• Serial or parallel bus extender and cables

• Bus expander/isolator

• GPIB mechanical switch

GPIB Hardware Overview

The AT-GPIB/TNT board, equipped with the TNT4882C ASIC, uses the 

GPIB software to transform any ISA or EISA bus computer into a fully 

functional GPIB Talker/Listener/Controller that has complete 

communications and bus management capability. The TNT4882C chip 

combines the circuitry of the NAT4882 ASIC, the Turbo488 

performance-enhancing ASIC, and GPIB transceivers to create a 

single-chip IEEE 488.2 Talker/Listener/Controller interface. The 

TNT4882C also implements the HS488 high-speed protocol, which 

increases the maximum data transfer rate of the AT-GPIB/TNT to 

1.6 Mbytes/s, depending on the computer and system configuration. For 

more information about HS488, refer to Chapter 7, GPIB Programming 

Techniques, in the GPIB User Manual for Win32.
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The AT-GPIB board, equipped with NAT4882 and Turbo488 ASICs, also 

uses the GPIB software to transform any ISA or EISA bus computer into a 

fully functional IEEE 488.2 Talker/Listener/Controller that has complete 

communications and bus management capability. The NAT4882 controller 

chip is fully compatible with the IEEE 488.2 standard. The Turbo488 

performance-enhancing ASIC boosts GPIB read and write transfers to rates 

exceeding 1 Mbytes/s.

The AT-GPIB/TNT board is fully compatible with all versions of AT-GPIB 

hardware. You can use standard GPIB cables to connect the AT-GPIB/TNT 

with up to 14 instruments. You can connect the AT-GPIB board with 

up to 13 instruments. If you want to use more than the maximum number 

of instruments, you can order a bus extender or expander from National 

Instruments. Refer to Appendix C, Specifications, for more information 

about the hardware specifications and recommended operating conditions.

GPIB Software Overview

The GPIB software for Windows NT includes a loadable Windows NT 

kernel device driver and supporting utilities.

The GPIB software includes the following components:

• Device driver

• Diagnostic test utility

• Configuration utility

• Interactive control program

• Utilities for software development and debugging

• Language interface libraries for Microsoft Visual C/C++ 2.0 or 

later, Borland C/C++ 4.0 or later, and Microsoft Visual Basic 4.0 

or later

• Virtual device driver and special DOS and Windows 3 drivers for 

running existing NI-488.2 for DOS and Windows 3 applications under 

Windows NT

• Sample applications that use NI-488 functions and NI-488.2 routines

For a detailed list of files, refer to Chapter 1, Introduction, in the GPIB 

User Manual for Win32. Refer to Appendix C, Specifications, for 

information about the GPIB software transfer rates.
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Time-Saving Development Tools

Your kit includes the GPIB software for Windows NT. In addition, you 

can order the LabWindows/CVI or LabVIEW software from National 

Instruments to speed your application development time and make it 

easier to communicate with your instruments. 

LabVIEW is an easy-to-use, graphical programming environment you 

can use to acquire data from thousands of different instruments, 

including IEEE 488.2 devices, VXI devices, serial devices, PLCs, and 

plug-in data acquisition boards. After you have acquired raw data, you 

can convert it into meaningful results using the powerful data analysis 

routines in LabVIEW. LabVIEW also comes with hundreds of 

instrument drivers, which dramatically reduce software development 

time, because you do not have to spend time programming the low-level 

control of each instrument.

LabWindows/CVI is similar to LabVIEW, except that it combines an 

interactive, easy-to-use development approach with the programming 

power and flexibility of compiled ANSI C code.

The GPIB Analyzer is another optional tool available from National 

Instruments that is useful in troubleshooting a variety of IEEE 488 

hardware and software problems. With its built-in time-stamping 

capability, you can easily determine the throughput and overhead 

of your GPIB systems. The GPIB Analyzer application can be used 

with the AT-GPIB/TNT+ and PCI-GPIB+ GPIB hardware, which 

provide GPIB Analyzer support along with the functionality of a 

high-performance GPIB Controller.

For ordering information, or to request free demonstration software, 

contact National Instruments.
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Chapter

2Hardware Configuration 
and Installation

This chapter describes how to configure and install your AT-GPIB/TNT or 

AT-GPIB board.

Using the Hardware Default Settings

The GPIB board default settings are suitable for most computer systems. 

However, if the default settings conflict with another device in your 

system, or if you need to install more than one GPIB board, you must 

reconfigure the hardware.

Table 2-1 shows the default settings for the switches and jumpers on the 

GPIB board. 

To modify the default settings of the GPIB board, proceed to the Configure 

the Hardware (Optional) section of this chapter. If you do not need to 

reconfigure the board, proceed to the Install the Hardware section.

Notice to EISA Users

If you have an EISA bus-based computer, you should use the EISA 

configuration files included on your GPIB distribution disk(s) to configure 

your GPIB board. The !NICC304.CFG file is the configuration file for the 

AT-GPIB/TNT and the !NICC005.CFG file is the configuration file for the 

AT-GPIB. Both files are located on the first distribution disk. Follow the 

instructions that came with your system to copy the appropriate EISA 

configuration file to your EISA configuration disk. Then, run your EISA 

configuration program, which uses the information in the configuration 

Table 2-1.  Hardware Default Settings

GPIB Board Setting Default

Base I/O address (hex) 2C0

DMA channel 5

Interrupt line (IRQ) 11
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file, to help you select appropriate settings for the GPIB hardware. After the 

program determines the settings, you must manually set the DIP switches 

and jumpers on the GPIB hardware to match the selections.

The DIP switches on the GPIB board use negative logic; the OFF position 

of a switch represents a logic one and the ON position represents a logic 

zero. As a result, some of the screens in your EISA configuration program 

might show a pattern of ones and zeros which is exactly opposite of the 

correct way to set your switch. To be sure you are setting the switch 

correctly, set it according to the ON and OFF pattern instead of the graphic 

representation of ones and zeros.

To modify the default settings of the GPIB board, proceed to the Configure 

the Hardware (Optional) section of this chapter. If you do not need to 

reconfigure the board, proceed to the Install the Hardware section.

Install the Hardware

Complete the following steps to install your AT-GPIB/TNT or AT-GPIB:

Caution Electrostatic discharge can damage several components on your AT-GPIB/TNT or 

AT-GPIB board. To avoid electrostatic damage when you handle the board, touch 

the antistatic plastic package to a metal part of your system chassis before you 

remove the board from the package.

1. Turn off your system. Keep the system plugged in so that it remains 

grounded while you install the AT-GPIB/TNT or AT-GPIB.

2. Remove the top cover (or other access panels) to give yourself access 

to the computer expansion slots.

3. Find an unused expansion slot in your computer. The AT-GPIB/TNT 

and AT-GPIB boards require a 16-bit ISA expansion slot. 

4. Remove the corresponding slot cover on the back panel of the 

computer.

!
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5. Insert the GPIB board into the slot with the GPIB connector sticking 

out of the opening on the back panel, as shown in Figure 2-1. It might 

be a tight fit, but do not force the board into place. 

Figure 2-1.  Installing the GPIB Board

6. Screw the mounting bracket of the GPIB board to the back panel rail 

of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Turn on your system and start Windows NT. 

The GPIB board installation is now complete. Proceed to Chapter 3, 

Software Installation and Configuration.
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Configure the Hardware (Optional)

Follow the instructions in this section to change the hardware default 

settings of the GPIB board before you install it. The GPIB board default 

settings are suitable for most computer systems. However, if the default 

settings conflict with another device in your system, or if you need to install 

more than one GPIB board, you must reconfigure the hardware. 

Refer to Table 2-1 for the default settings for the switches and jumpers on 

the GPIB board.

Refer to Figure 2-2 or Figure 2-3 to locate the switches and jumpers on 

your GPIB board.
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Figure 2-2 shows the location of the configuration jumpers and switches on 

the AT-GPIB/TNT board.

Figure 2-2.  AT-GPIB/TNT Parts Locator Diagram

1 Product Name, Revision Letter, and Assembly Number
2 Base I/O Address (SW1)
3 Serial Number

4 DMA Channel
5 Interrupt Level
6 Shield Ground (W3)



1

4 65

2 3
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Figure 2-3 shows the location of the configuration jumpers and switches on 

the AT-GPIB board.

Figure 2-3.  AT-GPIB Parts Locator Diagram

Selecting the Base I/O Address
Computers with an ISA or EISA bus have a segment of memory reserved 

for input and output. This segment is called I/O address space. The base I/O 

address of a plug-in board such as the GPIB board is the first position in the 

I/O address space occupied by the plug-in interface board. 

1 Product Name and Revision Letter
2 Assembly Number
3 Serial Number
4 DMA Channel

5 Interrupt Level
6 Base I/O Address (U25)
7 Shield Ground (W1)

1

3

4 5 6 7

2
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By default, the GPIB board is configured to use base I/O address 2C0 hex. 

With this setting, the board uses the I/O range 2C0 hex through 2DF hex. If 

another device is already using this I/O range, or if you are installing more 

than one board, complete the following steps to reconfigure the base I/O 

address setting:

1. Choose a new base I/O address setting. If you are installing more than 

one GPIB board, each board must use a unique base I/O address. 

Table 2-2 lists the possible switch settings, the corresponding base 

I/O addresses, and the I/O address space used for each setting. The 

default settings are in bold italics.

Table 2-2.  Possible Base I/O Address Switch Settings

Switch Setting
Base I/O

Address (hex)

I/O Address Space

Used (hex)A9 A8 A7 A6 A5

0 1 0 0 0 100 100 to 11F

0 1 0 0 1 120 120 to 13F

0 1 0 1 0 140 140 to 15F

0 1 0 1 1 160 160 to 17F

0 1 1 0 0 180 180 to 19F

0 1 1 0 1 1A0 1A0 to 1BF

0 1 1 1 0 1C0 1C0 to 1DF

0 1 1 1 1 1E0 1E0 to 1FF

1 0 0 0 0 200 200 to 21F

1 0 0 0 1 220 220 to 23F

1 0 0 1 0 240 240 to 25F

1 0 0 1 1 260 260 to 27F

1 0 1 0 0 280 280 to 29F

1 0 1 0 1 2A0 2A0 to 2BF

1 0 1 1 0 2C0 2C0 to 2DF
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2. Locate the base I/O address switch at SW1 on your AT-GPIB/TNT 

board or at U25 on your AT-GPIB board. Refer to the appropriate parts 

locator diagram, Figure 2-2 or 2-3. 

3. Change the switch settings to configure the GPIB board to the new 

base I/O address.

Press down on the side marked OFF to select a binary value of 1 for the 

corresponding address bit. Press down on the ON side of the switch to 

select a binary value of 0. Refer to Figure 2-4 for an example of the 

switch settings and corresponding base I/O addresses.

1 0 1 1 1 2E0 2E0 to 2FF

1 1 0 0 0 300 300 to 31F

1 1 0 0 1 320 320 to 33F

1 1 0 1 0 340 340 to 35F

1 1 0 1 1 360 360 to 37F

1 1 1 0 0 380 380 to 39F

1 1 1 0 1 3A0 3A0 to 3BF

1 1 1 1 0 3C0 3C0 to 3DF

1 1 1 1 1 3E0 3E0 to 3FF

Table 2-2.  Possible Base I/O Address Switch Settings (Continued)

Switch Setting
Base I/O

Address (hex)

I/O Address Space

Used (hex)A9 A8 A7 A6 A5
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Figure 2-4.  Base I/O Address Switch Settings

4. Record your new settings on the Hardware and Software 

Configuration Form in Appendix D, Customer Communication.

5. Remember that after you install the GPIB software, you must use the 

GPIB Configuration utility to configure your software settings to 

match your new hardware settings. Refer to the Configure the Software 

section in Chapter 3, Software Installation and Configuration, for 

information about the GPIB Configuration utility.
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Selecting the Interrupt Request Line
Computers with an ISA or EISA bus have a series of interrupt request lines 

available to devices. Devices use interrupts to get immediate service from 

the CPU for asynchronous events. Your GPIB hardware and software use 

interrupts to get service from the CPU when necessary. 

Note Do not disable interrupts. The GPIB software for Windows NT requires interrupts 

to be enabled. It does not work properly with interrupts disabled.

By default, the GPIB board is configured to use interrupt request line 11. If 

this is not an acceptable setting or if you are installing more than one board, 

complete the following steps to reconfigure the interrupt request line:

1. Choose a new interrupt request line (IRQ) setting. 

You can configure the GPIB board to use any of the following interrupt 

lines: IRQ3, 4, 5, 7, 9, 10, 11, 12, or 15. Do not use interrupt line 6 

or 14. On most systems, the diskette drive controller uses interrupt 

line 6 and the hard disk drive controller uses interrupt line 14.

If you are installing more than one GPIB board, each board must use a 

unique IRQ setting.

2. Find the jumpers that set the interrupt request line. The jumpers are 

located on the lower edge of your GPIB board. Refer to the appropriate 

parts locator diagram, Figure 2-2 or 2-3.

3. Change the jumper settings to configure the GPIB board to the new 

interrupt request line.

To use lines 10, 11, 12, or 15, use the jumper block shown in 

Figure 2-5. To use interrupt lines 3, 4, 5, 7, or 9, use the jumper block 

shown in Figure 2-6. 

Figure 2-5 shows the setting for IRQ11. 

Figure 2-5.  Interrupt Jumper Setting for IRQ11 (Default Setting)
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Figure 2-6 shows the setting for IRQ5.

Figure 2-6.  Interrupt Jumper Setting for IRQ5

4. Record your new settings on the Hardware and Software 

Configuration Form in Appendix D, Customer Communication.

5. Remember that after you install the GPIB software, you must use the 

GPIB Configuration utility to configure your software settings to 

match your new hardware settings. Refer to the Configure the Software 

section in Chapter 3, Software Installation and Configuration, for 

information about the GPIB Configuration utility.

Selecting the DMA Channel
Direct memory access (DMA) refers to data transfers directly to or directly 

from devices such as the GPIB board and system memory. Your GPIB 

hardware and software are designed to perform DMA. In most cases, data 

transfers using DMA are significantly faster than programmed I/O 

transfers, which use more CPU time.

By default, the GPIB board is configured to use DMA channel 5. If this is 

not an acceptable setting or if you are installing more than one board, 

complete the following steps to reconfigure the DMA channel:

1. Choose a new DMA channel setting. 

You can use channel 5, 6, or 7. If you are installing more than one 

GPIB board, each board must either use a unique DMA channel or 

must not use DMA at all. 

2. Locate the jumpers that select the DMA channel. Refer to the 

appropriate parts locator diagram, Figure 2-2 or 2-3. 

3. Change the jumper settings to configure the GPIB board to the new 

DMA channel. To select a new DMA channel, you must set both the 

DMA Acknowledge and DMA Request lines, as shown in Table 2-3.
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Figure 2-7 shows the jumper position for selecting DMA channel 7. 

Figure 2-7.  DMA Channel Jumper Setting for DMA Channel 7

4. Record your new settings on the Hardware and Software 

Configuration Form in Appendix D, Customer Communication.

5. Remember that after you install the GPIB software, you must use the 

GPIB Configuration utility to configure your software settings to 

match your new hardware settings. Refer to the Configure the Software 

section in Chapter 3, Software Installation and Configuration, for 

information about the GPIB Configuration utility.

Table 2-3.  DMA Channels
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Using Programmed I/O for GPIB Transfers
As an alternative to DMA transfers, you can use programmed I/O. To use 

programmed I/O, disable DMA for the GPIB board by moving the jumpers 

as shown in Figure 2-8.

Figure 2-8.  DMA Jumper Setting for No DMA Channel

Setting the Shield Ground Configuration
The GPIB board is set at the factory with the jumper in place to connect the 

logic ground of the GPIB board to its shield ground. This configuration 

minimizes EMI emissions. 

Caution The GPIB board was tested for compliance with FCC standards with the shield 

ground connected to logic ground. Removing the jumper might cause EMI 

emissions to exceed any or all of the applicable standards.

If your application requires that logic ground be disconnected from shield 

ground, complete the following steps:

1. Refer to Figure 2-2 to locate the shield ground jumper W3 on the 

AT-GPIB/TNT board. If you are using the AT-GPIB board, refer to 

Figure 2-3 to locate the shield ground jumper W1. 
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2. Remove the jumper and place it across only one of the jumper pins, as 

shown in Figure 2-9. 

Figure 2-9.  Ground Configuration Jumper Settings

3. Record the jumper setting on the Hardware and Software 

Configuration Form in Appendix D, Customer Communication. 

Now that you have properly configured the hardware, return to the Install 

the Hardware section at the beginning of this chapter for installation 

instructions.

Logic Ground Connected to Shield Ground (Default)

Logic Ground Disconnected from Shield Ground
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Chapter

3Software Installation 
and Configuration

This chapter describes how to install and configure the GPIB software for 

Windows NT. 

Install the Software

After you have installed and configured the hardware, you are ready to 

install the GPIB software. Complete the following steps to install the GPIB 

software for Windows NT:

1. Log onto your Windows NT system using the Administrator 

account. The GPIB setup program must have Administrator 

privileges because the program modifies the configuration registry of 

your system.

2. Insert the CD GPIB Software for Windows NT/98/95. The CD autoplay 

feature automatically launches the setup wizard.

The setup wizard guides you through the necessary steps to install the 

GPIB software. You can go back and change values where appropriate 

by clicking on the Back button. You can exit the setup if necessary by 

clicking on the Cancel button.

Note If you do not have a CD drive and would like to order the GPIB software on floppy 

disks, contact National Instruments and order part number 777780-01.

Before you use the GPIB software, you must reconfigure the software. 

Refer to the next section, Configure the Software, for instructions on 

running the GPIB Configuration utility.

Configure the Software

The GPIB Configuration utility is an interactive utility you can use to 

examine or modify the configuration of the GPIB driver. You must run the 

GPIB Configuration utility before you can use the GPIB software for 

Windows NT. Complete the following steps to run the utility:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon.
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The GPIB Configuration utility displays a list of all the GPIB boards 

and device names. 

2. In the GPIB Configuration dialog box, select a GPIB interface from 

the GPIB Board list. If you are using only one GPIB interface, select 

GPIB0.

3. Click on the Board Type button. Select AT-GPIB/TNT from the list 

that appears. Click on the OK button.

4. Configure your AT-GPIB/TNT interface:

a. Click on the Configure button to bring up the AT-GPIB/TNT 

Configuration dialog box, as shown in Figure 3-1.

Figure 3-1.  AT-GPIB/TNT Configuration Dialog Box

b. If you are not using the default GPIB hardware settings, you must 

modify the Base I/O Address, Interrupt Level, and DMA 

Channel to match your AT-GPIB/TNT hardware settings.

c. Click on the OK button.

d. In the GPIB Configuration dialog box, click on the OK button to 

save your changes and exit the utility.

e. In the Restart the GPIB Software? dialog box, click on the Yes 

button.
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5. (Optional) Configure the GPIB software settings:

a. Select Start»Settings»Control Panel and double-click on the 

GPIB icon.

b. You can configure additional items, such as the GPIB primary 

address or I/O timeout, but they are normally configured at run 

time by your application program. To examine or edit a setting, 

double-click on its name. You can use the online help if you have 

any questions. For more information about GPIB Configuration 

utility options, refer to the GPIB User Manual for Win32 or use 

the online help.

c. To save your changes and exit the utility, click on the OK button. 

To discard the changes and exit the utility, click on the Cancel 

button.

After you install and configure the software, you should verify the 

installation. Continue to Chapter 4, Verify the Installation.
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Chapter

4Verify the Installation

This chapter describes how to verify the hardware and software 

installation.

You can use the Diagnostic utility, installed with your GPIB software, to 

test the hardware and software installation. The Diagnostic utility verifies 

that your hardware and software are functioning properly and that the 

configuration of your GPIB interfaces does not conflict with anything else 

in your system. 

To run the Diagnostic utility, select the Diagnostic item under Start» 

Programs»National Instruments GPIB.

After you start the Diagnostic utility, test your GPIB interfaces by clicking 

on the Test All button. If the Diagnostic utility test is successful, it puts a 

checkmark next to the interface and changes its status from untested to 

passed. If the Diagnostic utility test fails, it puts an X next to the interface, 

and changes its status from untested to failed. Figure 4-1 shows the 

Diagnostic dialog box after it has tested some GPIB interfaces.

Figure 4-1.  Diagnostic Utility after Testing
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To get details on any of the tested GPIB interfaces, select the interface and 

click on the Details button. For each failed GPIB interface, select it and 

click on the Details button to get a description of the failure. Use that 

information and the information in Appendix B, Troubleshooting and 

Common Questions, to troubleshoot the problem. Troubleshooting 

information is also available in the Diagnostic utility online help, which 

you can access by clicking on the Help button.
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Chapter

5Begin to Use the 
GPIB Software

This chapter helps you get started with the GPIB software for 

Windows NT.

Getting Started with LabVIEW

LabVIEW is a fully-functional graphical programming environment used 

to develop measurement and automation applications. LabVIEW features 

comprehensive libraries for instrument control, data analysis, and data 

presentation. If you already installed LabVIEW, you can use the LabVIEW 

GPIB functions without any additional installation. To learn about the basic 

concepts of GPIB communication, refer to the LabVIEW GPIB functions 

chapter in the LabVIEW User Manual. To learn more about each GPIB 

function, refer to the LabVIEW Function and VI Overview Manual and the 

online help.

National Instruments provides LabVIEW instrument drivers to simplify 

application development. Instrument drivers are high-level functions that 

eliminate the need to learn the complex, low-level programming commands 

for each instrument.   For more information, refer to Chapter 7, Getting 

Started with a LabVIEW Instrument Driver, in the LabVIEW User Manual. 

If you want to write your own instrument driver, National Instruments 

provides application notes that help you get started.

To use instrument drivers in LabVIEW, select the Instrument Wizard 

from the Project menu.

For more information about National Instruments products, refer to our 

web site at http://www.natinst.com/products/.

Getting Started with LabWindows/CVI

LabWindows/CVI is an interactive C development environment used to 

build measurement and automation applications. It provides 

comprehensive libraries for instrument control, data analysis, and data 

presentation. If you already installed LabWindows/CVI, you can use the 
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LabWindows/CVI GPIB Library without any additional installation. 

The LabWindows/CVI GPIB Library includes the functions documented 

in your NI-488.2 or NI-488.2M reference manual, as well as several 

additional functions, which are documented in the GPIB library chapter of 

the LabWindows/CVI Standard Libraries Reference Manual. To help you 

use the GPIB functions, LabWindows/CVI provides function panels for the 

GPIB Library. To access the function panels, select GPIB/GPIB 488.2 

from the Library menu of the Project or Source windows. For 

information about using function panels, refer to the function panels 

chapter in the LabWindows/CVI User Manual.

If you need to program a GPIB instrument, you might want to use an 

instrument driver. An instrument driver is a set of high-level C functions for 

controlling a specific instrument. The low-level steps to control the 

instrument and read data are encapsulated in the high-level functions. You 

can write an instrument driver yourself, or you can use one that is already 

written. When you purchase LabWindows/CVI, you get free access to a 

library of drivers for hundreds of instruments. For more information about 

instrument drivers, refer to the project window chapter in the 

LabWindows/CVI User Manual.

For more information about National Instruments products, please refer to 

our web site at http://www.natinst.com/products/.

Introduction to the Win32 Interactive Control Utility

You can use the interactive control utility to enter NI-488 functions and 

NI-488.2 routines interactively and see the values returned by the function 

calls. You can use this utility to do the following: 

• Verify GPIB communication with your device.

• Learn the NI-488 functions and NI-488.2 routines before you write 

your application.

• Become familiar with the commands of your device.

• Receive data from your GPIB device.

• Troubleshoot problems with your application.

To run the Win32 Interactive Control utility, select the Win32 Interactive 

Control item under Start»Programs»National Instruments GPIB. 

This utility includes extensive online help, which you can access by 

entering help at the : prompt. For more information about the Win32 

Interactive Control utility, refer to the GPIB User Manual for Win32.
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Introduction to the NI Spy Utility

Included with the GPIB software is NI Spy, a Win32 utility that monitors 

and records multiple National Instruments APIs (for example, NI-488.2 

and VISA). You can use NI Spy to monitor Win32, Win16, and DOS GPIB 

applications. Use NI Spy to do the following: 

• Capture information about NI-488 functions and NI-488.2 routines as 

your GPIB applications invoke them.

• Display captured information, including, but not limited to, input and 

output parameter values, I/O buffer contents, and return values.

• Save, restore, and print captured information.

To run NI Spy, select the NI Spy item under Start»Programs»National 

Instruments GPIB. 

For more information about the NI Spy utility, refer to Chapter 5, NI Spy 

Utility, in the GPIB User Manual for Win32, or use its built-in, 

context-sensitive online help.

Running Existing GPIB Applications

You can run existing Win32, Win16, and DOS GPIB applications under 

Windows NT. 

Win32 and Win16 GPIB applications run without any special 

modifications. To run an existing DOS GPIB application, complete the 

following steps.

Load the special GPIB device driver gpib-nt.com instead of gpib.com, 

which you normally use with DOS. When you install the GPIB software, 

the GPIB setup program copies gpib-nt.com into a new subdirectory 

called doswin16. To use gpib-nt.com, you must modify your 

config.nt file to load gpib-nt.com whenever a DOS application runs. 

The config.nt file is located in your winnt\system32 directory, where 

winnt is your Windows NT directory, for example, c:\windows. The 

GPIB setup program modifies the config.nt file by adding the following 

lines:

REM *** To run DOS GPIB applications, uncomment the 

REM *** following line

REM device=path\doswin16\gpib-nt.com
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where path is the directory in which you installed the GPIB software.

To load gpib-nt.com, locate these lines in your config.nt file and 

delete REM from the third line, as follows:

REM *** To run DOS GPIB applications, uncomment the 

REM *** following line

device=path\doswin16\gpib-nt.com

where path is the directory in which you installed the GPIB software.

General Programming Considerations

As you begin developing your Win32 GPIB application, remember the 

following points:

• For your C/C++ application, you must include the NI-488.2M header 

file, decl-32.h, in your source code. 

• You can access the GPIB software through the 32-bit DLL, 

gpib-32.dll, either by linking with one of the language interfaces 

provided with the GPIB software, or by using direct DLL entry from 

other programming environments.

• Several sample GPIB applications are included with the GPIB 

software. Use these as a guide for your own application development.

For information about choosing a programming method, developing your 

application, or compiling and linking, refer to the GPIB User Manual for 

Win32. For detailed information about each NI-488 function and NI-488.2 

routine, refer to the NI-488.2M Function Reference Manual for Win32 or 

the online help.
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Appendix

AUninstalling the 
Hardware and Software

This appendix describes how to uninstall your AT-GPIB/TNT and the GPIB 

software from Windows NT.

Uninstalling the Hardware

Before you physically remove the GPIB hardware from your system, you 

must remove the hardware information using the GPIB Configuration 

utility. Complete the following steps to remove the hardware information:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon.

2. In the GPIB Configuration dialog box, select the GPIB interface you 

want to remove from the GPIB Board list.

3. Click on the Board Type button and select None from the list that 

appears, as shown in Figure A-1. Click on the OK button to save the 

new Board Type setting.

Figure A-1.  Board Type Dialog Box

4. Click on the OK button to save your changes and exit the GPIB 

Configuration utility.

5. Shut down Windows NT, turn off your system, and physically remove 

the interface from your system.



Appendix A Uninstalling the Hardware and Software

AT-GPIB/TNT for Windows NT A-2 © National Instruments Corporation

Uninstalling the Software

Before you uninstall the GPIB software, you should set the Board Type for 

your GPIB interface(s) to None in the GPIB Configuration utility, as 

described in the previous section. Complete the following steps to uninstall 

the GPIB software:

1. Select Start»Settings»Control Panel and double-click on the 

Add/Remove Programs icon. The dialog box shown in Figure A-2 

lists the software available for removal.

Figure A-2.  Add/Remove Programs Properties Dialog Box
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2. Select the GPIB software you want to remove and click on the 

Add/Remove button. The uninstall program removes all folders, 

programs, DLLs, and registry entries associated with the GPIB 

software. During uninstallation, you are prompted about deleting 

shared components, as shown in Figure A-3. Click on Yes, No, or 

No to All to continue with the uninstallation.

Figure A-3.  Removed Shared Component Dialog Box

If you have not physically removed your hardware, shut down 

Windows NT, turn off your system, and remove the GPIB hardware.

The uninstall program removes only items that the GPIB setup program 

installed. If you add anything to a directory created by the GPIB setup 

program, the uninstall program does not delete that directory. You need to 

remove any remaining components yourself.

If you want to reinstall the GPIB hardware and software, refer to Chapter 2, 

Hardware Configuration and Installation, and Chapter 3, Software 

Installation and Configuration.
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Appendix

BTroubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers some 

common questions.

Troubleshooting Diagnostic Utility Failures

The following sections explain common error messages generated by the 

Diagnostic utility.

Missing Software Components
This error occurs if the software components that are necessary for the 

GPIB software for Windows NT to function correctly are not present in the 

system. If you encounter this problem, reinstall the GPIB software for 

Windows NT and run the Diagnostic utility again.

No GPIB Interfaces Present
This error occurs if there are no GPIB interfaces physically present in the 

system or there is a resource conflict with the interfaces that are installed. 

If you encounter this problem, use the GPIB Configuration utility to 

examine the installed GPIB interfaces and the resources assigned to each. 

Then, run the Diagnostic utility again.

To access this information in the GPIB Configuration utility, complete the 

following steps:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon.

2. Click on the Board Type button and verify that the type of GPIB 

interface listed for each logical board name is correct. Click on the OK 

button to return to the main dialog box.

3. Double-click on each board name and verify that the hardware settings 

displayed in the dialog box match your actual hardware settings.
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GPIB Cables Need To Be Disconnected
This error occurs if you have any GPIB cables connected to the GPIB 

interface. Disconnect all GPIB cables and run the Diagnostic utility again.

Address Resource Conflict
This error occurs if the address resources assigned to a GPIB interface 

conflict with the address resources being used by other devices in the 

system. To resolve an address resource conflict, refer to the Resolving 

Resource Conflicts section, later in this appendix. After you have resolved 

the conflict, run the Diagnostic utility again.

Interrupt Resource Conflict
This error occurs if the interrupt resources assigned to a GPIB interface 

conflict with the interrupt resources being used by other devices in the 

system. To resolve an interrupt resource conflict, refer to the Resolving 

Resource Conflicts section, later in this appendix. After you have resolved 

the conflict, run the Diagnostic utility again.

DMA Resource Conflict
This error occurs if the DMA resources assigned to a GPIB interface 

conflict with the DMA resources being used by other devices in the system. 

To resolve a DMA resource conflict, refer to the Resolving Resource 

Conflicts section, later in this appendix. After you have resolved the 

conflict, run the Diagnostic utility again.

Single-Cycle DMA Required
This error occurs if the Diagnostic utility detects that it is unable to perform 

demand-mode DMA for the GPIB interface and that you have not 

configured the GPIB software to use single-cycle DMA. GPIB interfaces 

that use the system DMA controller, such as the AT-GPIB/TNT, normally 

use demand-mode DMA. If you encounter this error, you should use the 

GPIB Configuration utility to configure the GPIB software to use 

single-cycle DMA for all DMA transfers, and then run the Diagnostic 

utility again.

To configure the GPIB software to use single-cycle DMA for a particular 

GPIB interface, complete the following steps:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon.

2. Double-click on the GPIB interface you want to configure.

3. Make sure that the Use Demand Mode DMA item is unchecked.
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GPIB Software Problem Encountered
This error occurs if the Diagnostic utility detects that it is unable to 

communicate correctly with the GPIB hardware using the installed GPIB 

software. If you encounter this error, shut down your system, restart it, and 

run the Diagnostic utility again. If the problem persists, reinstall the GPIB 

software for Windows NT. 

Unknown Problem Encountered
This error occurs if an unknown problem is encountered when you try to 

execute the Diagnostic utility. If this error occurs, shut down your system, 

restart it, and run the Diagnostic utility again. If the problem persists, 

reinstall the GPIB software for Windows NT. 

Resolving Resource Conflicts

Resource conflicts occur when your system contains hardware that is 

configured to use the same resources as your GPIB interface. The GPIB 

driver detects some resource conflicts when it loads. When the driver 

detects conflicts as it loads, it records an error message describing the 

conflict. You can use the Event Viewer, as described in the following 

section, Using Windows NT Diagnostic Tools, to see which resource is in 

conflict.

Once you have identified the resource that caused the conflict, use the GPIB 

Configuration utility to reconfigure your GPIB interface so that it uses 

conflict-free resources. To help in the selection of conflict-free resources, 

Microsoft has provided a utility called Windows NT Diagnostics. This 

utility displays a list of the I/O port addresses, interrupt levels, and DMA 

channels that your system is currently using. You can assign resources not 

listed by this utility to your GPIB interface.

To run the Windows NT Diagnostics utility, select Start»Programs» 

Administrative Tools»Windows NT Diagnostics.
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Using Windows NT Diagnostic Tools

There are many reasons why the GPIB driver might not load. If the software 

is not properly installed or if there is a conflict between the GPIB hardware 

and the other hardware in the system, the GPIB driver fails to start. Two 

Windows NT utilities are useful in determining the source of the problem: 

the Devices applet in the Control Panel, and the Event Viewer. The 

following sections describe the information available through each utility.

Examining NT Devices To Verify the GPIB Installation
To verify whether the GPIB devices are installed correctly (that is, that the 

devices are started), select Start»Settings»Control Panel and 

double-click on the Devices icon. 

This utility lists all of the devices detected by Windows NT. Each device 

has a status associated with it. If the GPIB driver is installed correctly, the 

following lines appear in the list of Windows NT devices:

Device Status Started

GPIB Board Class Driver Started Automatic

GPIB Device Class Driver Started Automatic

You should also see one or more lines similar to the following:

Device Status Started

GPIB Port Driver (AT-GPIB) **** System

GPIB Port Driver (PCI-GPIB) **** System

The GPIB Board Class Driver, the GPIB Device Class Driver, and at least 

one of the GPIB Port Drivers listed by the Devices applet should have a 

status of Started. If not, refer to the next section, Examining the NT 

System Log Using the Event Viewer.

If the GPIB Class Driver lines are not present or at least one GPIB Port 

Driver line is not present, the GPIB software is not installed properly. You 

should reinstall the GPIB software. Refer to Chapter 3, Software 

Installation and Configuration, for installation instructions.

Examining the NT System Log Using the Event Viewer
Windows NT maintains a system log. If the GPIB driver is unable to start, 

it records entries in the system log explaining why it failed to start. To 

examine the system log by running the Event Viewer utility, select 

Start»Programs»Administrative Tools»Event Viewer. 
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Events that might appear in the system log include the following:

• The system cannot locate the device file for one or more of the devices 

that make up the GPIB driver and an event is logged that The system 

cannot find the file specified. In this case, the GPIB 

software is not installed properly. You should reinstall the GPIB 

software. Refer to Chapter 3, Software Installation and Configuration, 

for installation instructions.

• A conflict exists between the GPIB hardware and the other hardware 

in the system. If this is the case, an event is logged that indicates the 

nature of the resource conflict. To correct this conflict, reconfigure the 

GPIB hardware and the GPIB software. Refer to Chapter 2, Hardware 

Configuration and Installation, and Chapter 3, Software Installation 

and Configuration, for configuration information.

Common Questions

How can I determine which type of GPIB hardware I have installed?

Run the GPIB Configuration utility: select Start»Settings»Control Panel 

and double-click on the GPIB icon.

How can I determine which version of the GPIB software I have 

installed?

Run the Diagnostic utility: select the Diagnostic item under 

Start»Programs»National Instruments GPIB. The Diagnostic utility 

displays the version of the GPIB software that is installed in a banner at 

the bottom of the window that appears.

How many GPIB interfaces can I configure for use with my GPIB 

software for Windows NT?

You can configure the GPIB software for Windows NT to communicate 

with up to four GPIB interfaces.

How many devices can I configure for use with my GPIB software for 

Windows NT?

The GPIB software for Windows NT provides a total of 100 logical devices 

for applications to use. The default number of devices is 32.
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Are interrupts and DMA required with the GPIB software for 

Windows NT?

Interrupts are required, but DMA is not.

How can I determine if my GPIB hardware and software are 

installed properly?

Run the Diagnostic utility: select the Diagnostic item under 

Start»Programs»National Instruments GPIB. Refer to the 

Troubleshooting Diagnostic Utility Failures section earlier in this 

appendix or the online help to troubleshoot any problems.

When should I use the Win32 Interactive Control utility?

You can use the Win32 Interactive Control utility to test and verify 

instrument communication, troubleshoot problems, and develop your 

application. For more information, refer to the Introduction to the Win32 

Interactive Control Utility section in Chapter 5, Begin to Use the 

GPIB Software.

How do I use a GPIB language interface?

For information about using GPIB language interfaces, refer to Chapter 3, 

Developing Your Application, in the GPIB User Manual for Win32.

What do I do if the Diagnostic utility fails with an error?

Use the Diagnostic utility online help, or refer to the Troubleshooting 

Diagnostic Utility Failures section earlier in this appendix. If you have 

already completed the troubleshooting steps, fill out the forms in 

Appendix D, Customer Communication, and contact National Instruments.

How do I communicate with my instrument over the GPIB?

Refer to the documentation that came from the instrument manufacturer. 

The command sequences you use are totally dependent on the specific 

instrument. The documentation for each instrument should include the 

GPIB commands you need to communicate with it. In most cases, NI-488 

device-level calls are sufficient for communicating with instruments. Refer 

to Chapter 3, Developing Your Application, in the GPIB User Manual for 

Win32, for more information.
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Can I use the NI-488 and NI-488.2 calls together in the same 

application?

Yes, you can mix NI-488 functions and NI-488.2 routines.

What can I do to check for errors in my GPIB application?

Examine the value of ibsta after each NI-488 or NI-488.2 call. If a call 

fails, the ERR bit of ibsta is set and an error code is stored in iberr. For 

more information about global status variables, refer to Chapter 3, 

Developing Your Application, in the GPIB User Manual for Win32.

What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of the 

Diagnostic utility test. Also, make sure you have filled out the forms in 

Appendix D, Customer Communication.
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Appendix

CSpecifications

This appendix describes the electrical, physical, and environmental 

characteristics of the AT-GPIB/TNT and AT-GPIB and the recommended 

operating conditions.

Hardware Characteristics

Table C-1.  Hardware Characteristics for the AT-GPIB/TNT

Characteristic Specification

Dimensions 10.67 by 16.51 cm 

(4.2 by 6.5 in.)

Power Requirement

(from PC AT I/O channel)

+5 VDC 50 mA Typical

120 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment:

   Component Temperature

   Relative Humidity

0° to 55° C

10% to 90%, noncondensing

Storage Environment:

   Temperature

   Relative Humidity

–20° to 70° C

5% to 90%, noncondensing

EMI FCC Class B Certified
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Software Transfer Rates

Table C-2.  Hardware Characteristics for the AT-GPIB

Characteristic Specification

Dimensions 10.67 by 16.51 cm 

(4.2 by 6.5 in.)

Power Requirement

(from PC AT I/O channel)

+5 VDC  0.66 A Typical

 1.5 A Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment:

   Component Temperature

   Relative Humidity

0° to 55° C

10% to 90%, noncondensing

Storage Environment:

   Temperature

   Relative Humidity

–20° to 70° C

5% to 90%, noncondensing

EMI FCC Class B Certified

Table C-3.  GPIB Software Transfer Rates for the AT-GPIB/TNT and AT-GPIB

GPIB Hardware Transfer Method

Maximum GPIB

Transfer Rate

AT-GPIB/TNT

3-wire (IEEE 488) 1.4 Mbytes/s*

High Speed (HS488) 1.6 Mbytes/s*

AT-GPIB  3-Wire (IEEE 488) 1.3 Mbytes/s*

* Actual speed may vary considerably from speed shown due to system and

instrumentation capabilities.
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Appendix

DCustomer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 

to help us solve your technical problems and a form you can use to comment on the product 

documentation. When you contact us, we need the information on the Technical Support Form and 

the configuration form, if your manual contains one, about your system configuration to answer your 

questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to quickly 

provide the information you need. Our electronic services include a bulletin board service, an FTP site, 

a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first try the 

electronic support systems. If the information available on these systems does not answer your 

questions, we offer fax and telephone support through our technical support centers, which are staffed 

by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files 

and documents to answer most common customer questions. From these sites, you can also download 

the latest instrument drivers, updates, and example programs. For recorded instructions on how to use 

the bulletin board and FTP services and for BBS automated information, call 512 795 6990. You can 

access these services at:

United States: 512 794 5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: 01635 551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: 01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use 

your Internet address, such as joesmith@anywhere.com, as your password. The support files and 

documents are located in the /support directories.
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a wide 

range of technical information. You can access Fax-on-Demand from a touch-tone telephone at 

512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mail at the 

Internet address listed below. Remember to include your name, address, and phone number so we can 

contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical 

support number for your country. If there is no National Instruments office in your country, contact 

the source from which you purchased your software to obtain support.

Country Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Brazil 011 288 3336 011 288 8528

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Quebec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 6120092 03 6120095

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

United Kingdom 01635 523545 01635 523154

United States 512 795 8248 512 794 5678



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and use 

the completed copy of this form as a reference for your current configuration. Completing this form 

accurately before contacting National Instruments for technical support helps our applications 

engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 

include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) __________________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB Display adapter __________________________

Mouse ___yes   ___no     Other adapters installed _______________________________________

Hard disk capacity _____MB Brand_________________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration ___________________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem: ___________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item. 

Complete a new copy of this form each time you revise your software or hardware configuration, and 

use this form as a reference for your current configuration. Completing this form accurately before 

contacting National Instruments for technical support helps our applications engineers answer your 

questions more efficiently.

National Instruments Products

GPIB interface type and revision ____________________________________________________

GPIB software for Windows NT/98/95 date on CD _____________________________________

Programming language interface version ______________________________________________

Shield ground connected to logic ground (yes or no) _____________________________________

Diagnostic utility results ___________________________________________________________

Board settings:

Other Products

Computer make and model ________________________________________________________

Microprocessor __________________________________________________________________

Clock frequency or speed __________________________________________________________

Type of monitor card installed ______________________________________________________

Windows NT version _____________________________________________________________

Application programming language (Microsoft C, and so on) ______________________________

Other boards in system ____________________________________________________________

Base I/O address of other boards ____________________________________________________

Interrupt level of other boards ______________________________________________________

DMA channels of other boards _____________________________________________________

Base I/O

Address

Interrupt

Level

DMA

Channel

gpib0 __________ __________ __________

gpib1 __________ __________ __________

gpib2 __________ __________ __________

gpib3 __________ __________ __________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 

This information helps us provide quality products to meet your needs.

Title: Getting Started with Your AT-GPIB/TNT and the GPIB Software for Windows NT

Edition Date: July 1998

Part Number: 320648E-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address __________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway 512 794 5678

Austin, Texas 78730-5039
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Glossary

Prefix Meanings Value

m- milli- 10–3

c- centi- 10–2

M- mega- 10 6

° degrees

% percent

A amperes

ANSI American National Standards Institute

API Application Program Interface

ASIC application-specific integrated circuit

C Celsius

CPU central processing unit

DIP dual inline package

DLL dynamic link library

DMA direct memory access

EISA Extended Industry Standard Architecture

EMI electromagnetic interference

FCC Federal Communications Commission

GPIB General Purpose Interface Bus

hex hexadecimal
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Glossary

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches

I/O input/output

IRQ interrupt request

ISA Industry Standard Architecture

kernel set of programs in an operating system that implements basic system 

functions

m meters

MB megabytes of memory

PC personal computer

PLC programmable logic controller

RAM random-access memory

s seconds

VDC volts direct current

VXI VME eXtensions for Instrumentation
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